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Introduction

CalcOne is a universal calculator that embodies many useful features 
and functions. It was designed with two things in mind: We want to offer a 
calculator with broad appeal and to insure the program uses very little 
program memory. Currently version 2.0 has scientific functions, financal 
calculations, does unit conversions, base conversions and only needs 
150K to run. The calculator will operate normally whether it is registered or 
not. However, until the calculator is registered, a reminder will be displayed 
and the user will have an opportunity to enter a registration number. A 
registration number can be obtained from 

Fantron Design Ltd.
242 Sugar Road
Bolton, MA 01740

by sending $12.50 and your name and address. With your registration, you 
will receive the next upgrades for free. We are planning to add stand alone 
applications that make it easy to edit and merge data files, compile 
programs and customize menus.

CalcOne is a universal shareware calculator program that can be 
operated in an algebraic (Standard) or Reverse Polish Notation (RPN) 
entry modes. If you don't have your own registration number, registration 
information can be found under the About CalcOne... menu item under the 
  menu. If you are running System 7, I suggest you make an alias  to 
CalcOne (click on the CalcOne icon once, and select Make Alias under the 
File menu) and place it in your Apple Menu Items folder. Then you will be 
able to start the calculator without having to go to the program's icon and 
double clicking on it.

Quick Start Guide

When starting CalcOne for the first time, a dialog box will appear that 
notifies you the program isn't registered.  Click on YES, and enter your 
registration number in next dialog box. There are times when you will need 
to register again. This may occur when you reset the program,  switch 
computers, or system software. If you loose your registration number, write 
us at the address above. Give us your name and address, and we will send 
your registration number again.



To start the calculator, double click on the CalcOne icon (or use the 
alias you have just put in the  menu). After registering, a picture of a 
calculator will appear on the computer screen. The calculator buttons are 
actuated by positioning the mouse's arrow over a calculator key and click 
once with the mouse button. As with other Macintosh applications, most 
functions have a key board equivalent, some of which are shown to the 
right of the menu item.



When the calculator appears, notice the menu items in the menu bar 
at the top of the screen. Click on the Mode menu, and you can chose 
between Standard and RPN entry modes as well as other features relating 
to the calculator operation. For those who like the Hewlett Packard 
calculators, chose the RPN menu item. For the more common algebraic 
entry system, chose the Standard menu item.

Also notice the Calculator menu. There are five calculators under 
this menu item which can be chosen. The Scientific calculator performs 
many logarithmic and trigonometric calculations. The Complex calculator 
performs these same functions with complex (real and imaginary) numbers. 
A Financial calculator will perform statistic and interest rate calculations. 
The Conversions calculator will convert from one unit measure to another, 
like meters to yards. And a Numerical calculator which does base 
conversions and logical operations has been added to version 2.0. Each of 
these calculators are discussed in detail in the following sections.

General Instructions



Some operations will be common to all five calculators and this 
section describes these general operating procedures. This section can be 
skipped by those who are familiar with other calculator products.



Preferences  :  

Under the Calculator item in the menu bar, there is a Preferences... 
menu item that allows you to set the color of the calculator and the type of 
decimal point you want to use. When you select preferences, a dialog box 
will appear with check boxes for the type of decimal point, a period "." or a 
comma ",". There will also be a Color Picker for those with a color 
Macintosh. Selecting Color Picker... will call the standard color picker dialog 
box where you can customize the color of your calculator.

When CalcOne is launched, it looks for a file named CalOne.pref in 
the current directory. If the file is found, CalcOne attempts to load it instead 
of the standard defaults. For more information on this, see the section 
called "Data Storage and Retrieval".

Standard   Entry Mode:  

In the Standard mode, numbers and the six operations 

 +, -, x, ÷, =, and [] 

are entered like an algebraic equation:

\x(1) \x(.) \x(2) \x(x) \x([( )]) \x(2) \x(+) \x(.) \x(8) \x([( )]) \x(=) 3.36

The key board can be used as long as you substitute the star * for the 
multiplication and the forward slash, /, for the division buttons.  The 
calculator should automatically know whether the [()] is an open, "[", or 
close, "]", and there can be up to 6 levels of {[()]}. 

The \x(Clr) button cancels any pending operation and sets the display to 
zero.

RPN   Entry:  

In the RPN entry mode, the mathematical operation is entered last.  
The first number is stored by clicking on the \x(ENTER) key, followed by the 
second number and so on. Then, the math operations are entered from last 
to first, and no equal sign is needed.



\x(1) \x(.) \x(2) \x(ENTER) \x(2) \x(ENTER) \x(.) \x(8) \x(+) \x(x) 3.36

The key board can be used as long as you substitute the star * for the 
multiplication and the forward slash, /, for the division buttons. The 
numbers you enter are stored in four registers that can be "rolled" by using 
the down arrow key. Try entering;



\x(1) \x(ENTER) \x(2) \x(ENTER) \x(3) \x(ENTER) \x(4)

and then click on the down arrow key several times. These four numbers 
will reappear in reverse sequence.

The \x(Clx) key only clears the display, x value, in memory. it has no effect 
on the other registers.

Display and Operation Instructions:

The left arrow is used to correct the number being entered. One-by-
one, the last key stroke will be removed form the number in the display.

\x(1) \x(.) \x(2) \x(8) \x(7) \x(<-) \x(<-) \x(=) 1.2

The \x(+/-) key changes the sign of the number in the display.

The \x(FIX) key is used to control the format of the display and the 
number of digits displayed. Four display modes can be selected with this 
key and the current setting is displayed as a small code in the top of the 
display window the first time \x(FIX) is selected;

Scientific S: displays the number as power of 10
Literal L: displays the number with a fixed number of decimals
Engineering E: displays the number in powers of 1000
Fixed F: displays the number in a fixed number of decimals but 
will switch to scientific when the number gets too big or too small.

Along with the little letter, a number will appear that shows the current setting for the number of digits after the 
decimal. This number will range from 0 to 9. There may be a letter F instead of a number. When \x(FIX) is selected, 
the current decimal point mode and number of digits are displayed. If this setting is OK, select any key except a 
number, decimal point, or \x(FIX). Selecting \x(FIX) again or again will change the decimal point mode from S to L to 
E to F and back to S until you have selected the desired display mode. The very next number you select will 
determine the number of digits after the decimal point. If the decimal point key is selected \x(.), the number of digits 
after the decimal point will "float". This means the last digits after the decimal are checked to see if they are zeros, 
and if they are, these zeros are not displayed.

The \x(EE) is used to enter a power of ten.



The \x(x-y) swaps the value displayed and the last value entered.

The \x(\r(x)) key finds the square root of the display if it is positive.

The \x(1/X) key finds the inverse of the display.

The \x(X2) key squares the display.

The \x(STO) key is used to store numbers in any of the 10 memory locations.  When you want to store a 
number, click on the \x(STO) key and a number between 0 and 9. When the \x(STO) key is selected, a small STO is 
displayed at the top of the display window. Along with the little STO will be a number. This is the default memory 
location. If any key is selected other than a number, the default memory location will be used for storage. The \x(STO) 
function can also be invoked from the keyboard with the "s" key

The \x(RCL) key works the same as the \x(STO), but recalls the value at  the memory number selected, or 
the default. Recall can also be chosen by pressing r on the keyboard.

The \x(INV) key turns the invert indicator on and off in the upper left hand corner of the display. When the 
INV is active, some of the function keys will operate in the inverse mode. For example, sin becomes arcsine. 

Displayed values can be cut and pasted into other applications by using the menu items under the Edit 
menu item. To get the number form the display, select the Copy menu Item under the Edit menu. Then, go to your 
other document or application and paste that number in. Numbers can pasted into the calculator form other 
documents by selecting the Paste menu item.  Cut or Copy the number from your other document, activate CalcOne, 
and select Paste. The number will appear in the display as if you entered it with the mouse or from the keyboard.



The Reset menu item will reset the calculators screen position, memory registers, operating modes and 
display options to a state similar to when you first started this program. Warning: You will have to enter your 
registration number again after resetting the calculator.

The calculator takes up a lot of room on the desktop. You can miniaturize the calculator by clicking on the 
bar below the display window. Another click anywhere in the miniature display will return the calculator to its normal 
size.

Each calculator key is mapped to the keyboard when the shift key or the caps lock key is down. The 
calculator can be operated while miniaturized or at full size.
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The two figure above show how the calculator keys are related to the keyboard keys. I like to use the calculator while 
it is miniaturized, so I have a copy of the keyboard map taped on my monitor. 

To get rid of the calculator, you can chose Quit from the File menu or click in the tiny box in the upper left 
hand corner of the calculator window. Your memories, calculator position on the screen, and other settings will be 
saved before the program quits. Next time you start the program, you can continue calculating where you left off. 
However, if you want to use the calculator for several different jobs, such as your monthly budget and your business 
finances, you can write data into files as explained in the next section.



Data Storage and Retrieval:

Data can be written into a file or read form a file that has already been created. This can be valuable for 
saving different data files for each sales account, for your home finances. Running balances can be kept in the 
memory location or in the display, and recalled at any time. The following is a list of calculator items saved in the data 
file (version 2.0):

Display and all stack items (RPN Mode).
All 10 memories and default numbers for STO, RCL and SUM.
RPN/Standard setting, calculator, and decimal point type.
Decimal point and Complex number Mode, angle type (e.g.. radians)
Financial memories for calculating interest, present value etc.
All pop up Menus.
Calculator color and location on screen.
Program and Paper Tape

To save a file, select the Save or Save As...  menu Item under the File menu in the menu bar. Selecting 
Save will write over the last file you wrote, or if this is the first save since you started the calculator, the data will be 
saved in a file named ClacOne.dat in the current directory. Chose Save As... if you want the data saved in another 
file. Then, use the standard save as... dialog box to navigate and save the data.

When the calculator starts up, the programs looks for a file called CalcOne.pref in the current directory. If 
this file is present, the calculator will attempt to load the data instead of the normal default settings. If you want a 
particular data file to be loaded every time the calculator is launched, save it as a data file called CalcOne.pref in the 
same folder as the CalcOne application.

If you want to load data from a CalcOne file, select Open from the File menu in the menu bar. Then navigate 
with the standard file dialog box until you fine the file you want.

Paper Tape  :  

CalcOne 2.0 has a paper tape display where up to 64 numbers and operations can be printed. The paper 
tape is started by selecting the Paper Tape menu item under the Mode menu. The paper tape is just a window where 
a history of calculator operations and results are written. Only eight lines are shown, but there are 64 stored in the 
records and can be viewed by using the sliding control at the far right of the calculator.

New lines are always copied form the display to the bottom of the stack of numbers. So, the oldest 
calculations are on the top and the newest are on the bottom.



The paper tape can be printed by selecting the Print menu item under the File menu in the menu bar To 
control the way numbers are printed, chose the Page Setup... menu item.

Items can be cut from the paper tape to correct wrong entries. However, text or numbers cannot to put on to 
the tape without using the calculator. Removing parts of the paper tape is done by selecting the offending part with 
the mouse. Place the mouse arrow on the beginning of the part you want to remove. Then press the mouse button 
and keep it pressed while moving the mouse arrow to the end of the offending part of the tape. As you do this, the 
text will become highlighted. If you want to remove the highlighted text and numbers, select the Cut menu item under 
the Edit menu in the menu bar. This will remove it from the tape and place it in the scrap and you may paste this into 
another document. 

Scientific and Complex Calculators

This section describes the functions that apply to the scientific and 
complex calculators.

When the \x(π) key is selected, the key will dissolve into a pop-up 
menu with several constants besides π. If you want π, don't move the 
mouse, and release the mouse button. The other constants can be chosen 
by selecting them with the mouse before releasing the mouse button. The 
C item is for customizing the menu as explained in the section Customizing 
Menus.

The \x(Log) key calculates the logarithm, in base 10, of the number in 
the display. The INV selector will case the \x(Log) key to calculate the inverse log, or 10 raised to the power 
of the value in the display.

The \x(ln) key calculates the natural logarithm, in base e, of the number in the display. The INV selector will 
case the \x(ln) key to calculate the inverse logarithm, or e raised to the power of the value in the display.



The \x(D-R) key is used to select the units of the angle that will be used for the trigonometric functions.

Degrees D:  360 degrees in a circle   
Radians R: 2π radians in a circle
Grads G: 400 grads in a circle
Unit Circle C: 1 circle in a unit circle

The \x(hyp) key will turn the hyperbolic trig function on and off, as indicated by the HYP in the upper left-
hand portion of the display.

The \x(SIN) key calculates the sine of the displayed number. The INV and HYP selector will case the \x(SIN) 
key to calculator the inverse sine, hyperbolic sine and the inverse hyperbolic sine.

The \x(COS) key calculates the cosine of the displayed number. The INV and HYP selector will case the 
\x(COS) key to calculator the inverse cosine, hyperbolic cosine and the inverse hyperbolic cosine.

The \x(TAN) key calculates the tangent of the displayed number. The INV and HYP selector will case the 
\x(TAN) key to calculator the inverse tangent, hyperbolic tangent and the inverse hyperbolic tangent.

Complex Calculator Only

Complex numbers are entered by inputting the real part (or 
magnitude) first the same way you would normally enter numbers, then 
begin entering the imaginary part (or angle) by selecting the i (or ∠ ) key 
first. The choice of entering the complex number in a real and imaginary or 
magnitude and angle format is determined by selecting the \x(P-R) key. The 
following example shows how to enter the complex number 1.2+4i:

\x(1) \x(.) \x(2) \x(i) \x(4) \x(=) 1.2 + 4i

The \x(*) key will convert the display to it's complex conjugate.

The \x(P-R) key changes the way complex numbers are entered, displayed, and  transferred to other 
calculators with four settings;



Real RE   
Imaginary IM
Magnitude MAG
Angle ANG

Since the other calculators can only handle one real number, the number transferred between calculators is 
determined by these four settings. Furthermore, the RE and IM setting will allow the entry and display of the complex 
number in terms of real and imaginary parts. When the MAG and ANG modes are selected, the entry and display of 
the complex number is done with the magnitude and angle of the number. The angle is displayed in degrees, radians, 
grads or unit circle according to the \x(D-R) setting. 

Financial Calculator 

The basic financial calculator functions are described above. The 
following explains the functions specific to the financial calculator.

The financial calculator has it's own pop up menu behind the \x(%) 
key. When the \x(%) is chosen from the pop-up menu, it converts the display into a percentage (divides the 
display by 100). The other choices in the pop-up menu will multiply the display by the indicated percentage (some are 
the current income tax rates). The Cust item is for customizing the menu as explained in the section Customizing 
Menus.

The \x(SUM) key adds the display to a value in memory. The memory location is chosen the same way as 
with the \x(STO) and \x(RCL) key as explained above. 

The \x(X!) key calculates the factorial of the displayed number if it is an integer greater than zero.



There are four statistical function keys to perform simple statistics.  These keys find the mean and standard 
deviation of a group of numbers entered with the \x(∑) key. To use the statistical functions, enter the data one number 
at a time and press the \x(∑) key when each number is entered. Then when all the data has been entered, the mean 
is displayed by selecting the \x( ) key. The \x( ) key finds the population standard deviation of the data and the 

\x( ) finds the sample standard deviation. 
 

\x(5) \x(5) \x(∑) \x(5) \x(4) \x(∑) \x(5) \x(1) \x(∑) 
\x(5) \x(5) \x(∑) \x(5) \x(3) \x(∑) \x(5) \x(4) \x(∑) 
\x( )  53.66667
\x( )  1.37437
\x( ) 1.50555

Select the \x(Clr) key twice to clear the registers before starting a new statistical calculation with new data.

Investment  calculations are supported by five keys. These keys are used to enter a value for a later 
calculation, or to initiate a calculation. The \x(%i) key is for entering or finding the periodic interest rate. The \x(N) and 
\x(PMT) keys are used for entering or calculating the number of payments or the payment value respectively.  The 
\x(PV) and \x(FV) keys are for entering the present or future value of an investment. You would start with four of these 
values, and then calculate the remaining one. These known values are entered by selecting  the \x(STO) key, then 
selecting one of the five investment keys:

\x(1) \x(0) \x(0) \x(0) \x(0) \x(0) \x(STO) \x(FV) 

The example above puts the value 100,000 in the future value register. Then the other three values are entered to 
prepare for a calculation. The remainder of this example calculates the interest rate needed to have $100,000 after 
10 years when you start with $10,000 and deposit $200 a month into the account:

\x(1) \x(0) \x(0) \x(0) \x(0) \x(STO) \x(PV) 
\x(1) \x(0) \x(X) \x(1) \x(2) \x(=) \x(STO) \x(N) 
\x(2) \x(0) \x(0) \x(STO) \x(PMT) 

\x(%i) 0.01256
\x(x) \x(1) \x(2) \x(=) 0.15071



You would need an interest rate of 1.256% per month or 15.071% per year to achieve the goal of 100,000.

Clicking twice on the \x(Clr) key will clear all the financial registers.

Conversion Calculator

The conversions calculator will convert between many common units 
of measure like meters to feet and Centigrade to Fahrenheit. This 
calculator includes some of the more common functions for the scientific 
and financial calculators. The conversions calculator has two extra 
windows next to the display that shows what units are where selected with 
the \x(Frm) key on the top and the units selected with the \x(To) key. 

There are two pop-up menus that control what units are used in the conversion process. You need to select 
two units, the units to convert from and the units to convert to. The pop-up menus under the \x(Frm) and \x(To) keys 
allow you to choose these two units. The menu under the \x(TO) key is rebuilt when a new \x(Frm) selection is made. 
The example below shows how many meters are equal to 100 yards:

\x(1) \x(0) \x(0) \x(Frm) 

\x(To) 91.43551



Numerical Calculator

The Numeric calculator has 16 number keys and a pop up menu 
where you can select the base of the numbers entered and the displayed. 
You will also notice additional keys for logical operations such as AND, OR 
and Exclusive OR. The number keys will become active or inactive 
depending on the base that you have selected. Any base number from 2 to 
16 can be displayed or entered by selecting the base from the pop up 
menu under the \x(^) key. The current base is displayed at the top of the 
display in a small number or letter that ranges from 2 to G.

Numbers in bases other than 10 can be manipulated like normal 
numbers in this calculator plus there are a few additional operations one 
can perform. Logical operations can be performed on long integers 
(between +231 and -231), but not floating point numbers. Before any of the logical operations, \x(AND), 
\x(OR), \x(Xor), and \x(NOT), the number is converted to a long integer. If the number is larger or smaller than a long 
integer, the results will be unpredictable.

The \x(ASC) key prints the ASCII character (in the current font) if the number in the display is between 0 and 
256. 

The \x(INT) key converts the displayed number to the largest integer less than the number in the display and 
sets the calculator in mode to do integer calculations.

The \x(Flt) key returns the calculator to a floating point calculation mode.

The logical operation have a lower priority than the mathematical functions which only applies to the 
standard entry mode. The hierarchy of operations are multiplication and division first, addition and subtraction 
second, and the logical operations last.



Customizing Menus

The pop-up menus can be customized by adding or subtracting items 
from the menu list. To customize a pop-up menu, select the C, Cust, or 
Customize menu item at the bottom of the pop-up menu.

You will get a dialog box with a menu key and several options for 
customizing the menu. These options are Insert, Add, Delete and Cancel. 
The conversions calculator has an additional item; Add ---.  If you are 
adding a new item, you must chose the location in the menu list. If you are 
deleting a menu item, you must select the item to be deleted. Position the 
mouse arrow on the little key near the top of the dialog box and press the 
mouse button. The figure above shows a π key because the dialog was 
called form the Scientific calculator pop-up menu item C. The pop-up 
menu you are editing will appear. Select the menu item that you want to 
delete, insert a new item before, or add a new item after it. Selecting the 
Insert button will insert the new menu item before the item selected. 
Choosing the Add button will add the new item after the menu item chosen. 
When editing the Conversions pop-up menu, a seperator line, using Add 
---, can only be added before another seperator line

For example, pressing on the π key pops up the menu of universal 
constants. We want to add the universal constant g after the speed of light, 
c. We select the c menu item and a c will appear next to the key. We select 



the Add button and another dialog box appears asking for the name of the 
new item:



Next, we enter g and click the OK bottom. Another dialog appears asking 
for the numerical value of g:

The gravitational constant on the surface of the earth is 9.8 m/s2, so we enter 9.8 
and click on the OK button. We have just add the constant g=9.8 to the pop-up menu.

Remember, when you quit the calculator, your custom menu will be gone forever unless you save it in a data file.  
Chose Save or Save as... for the File menu item in the menu bar and save the menu in a new data file. See the 
section on saving and recalling files for more on data files.



Programming

This chapter explains the programming features of CalcOne. Almost 
any sequence of key strokes can be programmed for repetitive execution. 
By selecting the Program menu item under the Mode menu, a set of 
programming keys will appear along with a paper tape display for the 
program. The program display window only holds 8 program steps whereas 
the program memory will hold 254. Use the sliding control at the far right to 
control the part of the program that is viewed and the insertion point of new 
instructions.
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Each key has an address according to its row and column, the first 
digit being the column and the second digit is the row.  The columns span 1 
to 14 where column one is the left most column. Since the number of 
columns exceeds 10,  the first digit in the address is a base 16 number. It 
could have an A,B,C, or D instead of a 10, 11, 12, or 13 respectively. The 
rows span from 1 to 6, with one being the top row in the numeric calculator. 
Notice that the Complex and Financial calculators have one extra column. 
This column of keys is column number seven, and the other calculators will 
have no column seven keys. Keep this in mind when interpreting key 
addresses.

The address does not depend on the calculator being used, so 
therefore it is very  important which calculator is active. The address related 
to a key, not a function. Each address can have five different meanings 
depending on which calculator is active.

Entering and Editing a program:

Select Program from the Mode menu in the menu Bar. The program 
keys and window will appear. Select keys on the calculator normally, and 



their address is automatically inserted where the symbol ">>" spears next 
to the program window. Whenever the program window is active, all key 
strokes will be inserted into the program.  If you want to use the calculator 
without the changing the program, dismiss the program window by 
selecting Program again in the Mode menu.



The  \x(Del) key deletes the program instruction currently being 
pointed to by the ">>" symbol.

The  \x(Rpl) key replaces the program instruction being pointed to by 
the ">>" symbol by the very next key that is pressed.

You can store the program by selecting Save under the File menu. 
See the section  "Data Storage and Retrieval".

Program Control:

The \x(Stp) key inserts a stop command into the program that will 
stop the program and reset the program counter.

The  \x(GO) key tells the calculator to start running the program from 
the address pointed to in the program window.

The \x(Pause) key insets an instruction to stop the program. It can be 
restarted again by selecting Run from the Mode menu or by using the \x(Go) 
key.

The  \x(SS) key is a debugging tool to single step through the program. Every time it is pressed the program 
executes one instruction, and displays the next instruction in the middle of the program display.

The  \x(Lbl) is used to define the very next key as a label or location in the program memory. Anytime you 
want to jump, branch or go to a specific location in the program, it must be identified by a label.  The labeled key can 
be any of the keys on the calculator, and the function that key normally performs is ignored this one time since it is 
used as a label. The following three paragraphs describe conditional and unconditional jumps to locations in the 
program that must be identified by labels.

If the program is being displayed in the small paper tape window, there is a Go To menu in the menu bar list 
the labels throughout the program. If Selecting a label from the Go To menu forces the program display window to go 
to the part of the program that has that label.

The  \x(GoT) function forces the program to jump to a specified location. The next program entry is a label, 
not a calculator function. The calculator searches for this label, and jumps to this part of the program. For example, if 
the program has a  \x(GoT) \x(=), the equals is not a function or operation, it is a label. The calculator searches the 
program for the two instructions  \x(Lbl) \x(=) and jumps to this location. If the label isn't found, the program ignores 
the go to command.



The \x(x=0), \x(x=y), \x(x<y), \x(x≤y) functions are used to test for a condition and jump to another part of the 
program if the condition is true. The next address in the program doesn't relate to a calculator key, but the label to 
where the program should jump. If the test is true, the calculator searches for the label with the corresponding code 
and jumps to that location in the program. If no label is found, the program ignores the test and continues. The "x" 
value is the number in the display, the "y" value is a register that is assigned a value with the \x(x-y) key or the 
\x(ENTER) key if your in the RPN mode.

Example Program:

The following listing is a program that successively calculates area of a unit circle. We will distribute more 
programs and tools in the future, however, this small example will help you get started. The area of a circle with a 
radius of one is equal to π. Calculating π is a common exercise in many computer courses for scientists and 
engineers. Imagine a circle centered on a graph at the origin. The part of the circle in the first quadrant is split up in 
four trapezoids of equal width. The area of the trapezoids is added, multiplied by four, and the program pauses. 

1 46 27 95 53 45 79 85
2 55 28 33 54 A5 80 75
3 84 29 7 55 75 81 55
4 55 30 43 56 B4 82 85
5 94 31 55 57 45 83 25
6 84 32 A5 58 86 84 45
7 55 33 45 59 53 85 86
8 86 34 95 60 B3 86 25
9 C5 35 B6 61 95 87 C3

10 85 36 45 62 B6 88 95
11 45 37 86 63 45 89 45
12 84 38 53 64 86 90 84
13 55 39 75 65 53 91 B4
14 94 40 55 66 B4 92 84
15 46 41 95 67 45 93 75
16 55 42 85 68 A4 94 C6
17 84 43 B5 69 75 95 45
18 55 44 45 70 B6 96 86
19 95 45 95 71 45 97 B6
20 55 46 33 72 84 98 84
21 85 47 75 73 75 99 75
22 C5 48 43 74 55 100 55
23 95 49 55 75 84 101 86
24 85 50 A4 76 45 102 D5
25 B5 51 A6 77 85 103 85
26 45 52 B6 78 B6 104 D6



Continue the calculations by pressing the \x(GO) key. Then the area in the first quadrant to split into eight 
trapezoids. Then, after another pause and anoth pree of the \x(GO) key, into 12 trapezoids, and so on. Each time the 
program pauses, the number in the display  will be closer and closer to π.

The data file CalcOne.dat that can on this disk has the program loaded and ready to run. The following is a 
listing of the program. Have fun.

The Future for CalcOne

The future for CalcOne is entirely up to you. You can exchange data, 
menu and programs in the data files with other CalcOne users. And you 
can build a library of data files. As this manual goes to press, we are 
planning to add tools to the CalcOne system to make it easier to program 
and customize. As a registered user, you will get these tools as soon as 
they become available. Here is a list of some things we are working on:

1. Data file editor. There are a lot of things in a data file. What if you 
want to load some of the data?  For example, you put a lot of time 
into creating new menus and save these in a data file. This data file 
will also have the calculator's color.  If you change the color of the 
calculator it would revert to the old color when the data file containing 
the new menus is recalled. The data file editor will tell you what is in 
the data file and allow you to change items, or copy parts from other 
files.

2. Menu Builder. You can easily add a few items to the pop-up menus 
one at a time. This becomes tedious when you want to completely 
overhaul the menus. The menu builder will make creating menus 
from scratch easy and fast by putting all the menu building controls at 
your fingertips.

3. Program compiler. Programming and debugging the calculator and 
is time consuming. The program compiler is a tool to help you create 
and debug programs. This will dramatically accelerate the program 
development cycle.

We hope that CalcOne is a small and powerful tool for your everyday use.


